## Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
<th>By</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>04/26/10</td>
<td>CIDI initial user guide</td>
<td>Latisha Collins</td>
</tr>
<tr>
<td>1.1</td>
<td>04/27/10</td>
<td>Final Edits</td>
<td>Nathan Hall</td>
</tr>
</tbody>
</table>
# Table of Contents

Introduction .................................................................................... 4  
Inquiry Dispute Process ................................................................. 5  
Types of Inquiries ........................................................................... 5  
  Resolution Time ............................................................................ 5  
  Time Sensitive Issues .................................................................... 6  
  Client Priority Field ..................................................................... 6  
Getting Started .............................................................................. 7  
Market Participant Portal (MPP) ..................................................... 8  
Customer Inquiry Dispute Page ..................................................... 10  
  Main Page ...................................................................................... 10  
Terminology ..................................................................................... 11  
  Field Definitions ........................................................................... 13  
Basic Navigation .............................................................................. 14  
How to Create a New Case (Inquiry Ticket) ................................... 16  
Add Comments ............................................................................... 21  
  View Comments ........................................................................... 22  
Searching ....................................................................................... 23  
  Advanced Search ......................................................................... 24  
How to Create a New Case (Settlement Dispute) ............................ 25  
Reports (printing cases) ................................................................. 28  
Special Tips .................................................................................... 30  
  Entry ID ....................................................................................... 30  
  Back Arrow, Go, Back to List ........................................................... 30  
Cloning a Case ............................................................................... 31  
Tracking Case Details .................................................................... 32  
Client Responses ............................................................................ 33
Introduction

The ISO has launched a new system to improve our customers’ ability to submit and track their business inquiries and disputes. The new system is called “CIDI”, the Customer Inquiry, Dispute & Information system. CIDI is pronounced like ‘city,’ and it replaces both IMS and SDS, our prior issues management and settlement dispute systems.

For our customers, CIDI represents a significant improvement over IMS and SDS. CIDI is built on a robust, web-based platform created by SalesForce.com, a global leader in Customer Relationship Management systems. With CIDI, you can:

- Assign your own priority to your issues (IMS only)
- Email from the system anyone you choose with information and updates on your tickets (IMS only for now, but the request has been made to add this feature for SDS)
- Receive automatic reminders including status changes, pending tasks for one of your tickets, or an action item reminder at a future follow-up date you can set.
- Enter longer text descriptions, up to 32,000 characters
- Attach and access files related to your ticket
- Enter text in Case Comments that track with dates the historical interactions, with the ISO (IMS only)
- Disagree with a resolution, provide comments and automatically re-assign the issue back to the ISO (IMS only)

CIDI was developed in partnership with a newly formed ISO customer focus group called CPG or Customer Partnership Group, and is designed with our customers in mind. The ISO has incorporated many suggestions from this group into the initial rollout and is looking forward to partnering with this group to develop and enhance the functionality and usability of CIDI as we move forward together.

We hope you find CIDI to be an effective tool for managing your business interactions with the ISO. Feel free to call your client representative if you have questions.

Thank you,

Don Fuller
Director, Customer Services and Industry Affairs
Inquiry and Dispute Process

Types of Inquiries

The following inquiries/cases can be entered into CIDI:

• Inquiries
  o Verifying or updating Master File information
  o Updates of personnel for application access
  o Inquiries on Charge Types
  o Metering questions
  o Scheduling Questions
  o Digital Certifications
  o Name changes
  o Additional SCIDs
  o New Banking Information
  o Market Simulation Issues

• Settlements Disputes

Those inquiries/cases that should not be entered into CIDI are:

• Connectivity issues; managed through the CAISO Help Desk
• Real Time issues; handled by the CAISO Real Time desks.

Resolution Time

The ISO is committed to meeting clients’ expectations regarding the fast resolution of cases. To the extent practical, the ISO will endeavor to resolve all cases within 10 business days or less. Settlement Disputes will continue to be processed as they are today according to the methodology outlined in Settlements and Billing BPM.

If an SC calls or emails their Client Representative to request a case be entered into CIDI, the Client Representative will enter the case into CIDI by the close of business on the day received. If the SC seeks faster attention to their case, they can enter the case directly into CIDI, and follow up with a phone call, thereby ensuring that the ISO team has all of the pertinent information and is aware of the case.
**Time Sensitive Cases**

If a case requires resolution within a 60-minute time horizon, the ISO strongly recommends that the SC contact their Client Representative by telephone.

**Client Priority Field**

In response to feedback from our customers, the ISO has included a customer priority field to assist the ISO in understanding the priority of cases that you submit. Please work with your client representative to establish a process regarding the use of this field.
Getting Started

You must have a Scheduling Coordinator ID (SCID) and have a CAISO Multi-Application (CMA) digital certificate installed along with access to the Portal before you can use CIDI.

1. Be sure to install the certificate per the instructions provided to you.

2. If you do not have a certificate and/or do not have access to the portal, then request access using the Application Access Request Form (AARF) located at:

   http://www.caiso.com/docs/2000/03/01/2000030110195926538.xls

   Once you have access, open Internet Explorer and type: https://portal.caiso.com. Bookmark this page.

3. The Market Participant Portal (MPP) Home page will be displayed with the Issue Management and Settlements Disputes views displayed within a Portlet similar to today.
Market Participant Portal (MPP)

The Market Participant Portal adds value to Market Participant businesses by streamlining access to secure ISO applications and business-critical information, enabling more efficient participation with the ISO by having:

- Centralized access to ISO applications
- Single log-on to applications using digital certificates
- Centralized access to public information sources of frequent use

MPP has Active Portlets to Issue Management, Settlements Disputes, the ISO Calendar, Market Notices, AWE and System Operating Messages. It also has links to legacy applications - ADS, SLIC, OMAR, SRS (no single sign-on) in addition to single sign-on links to new applications – RR (Resource Requirements).

All the SCIDs will be available to select per digital certificate profile. Individual SCIDs can be selected to display all issues entered for that specific SCID or all Issues for all SCIDs within your profile can be displayed.
The CIDI button on the previous page takes you to the CIDI application. However, the individual portlets are also displayed in the center of the MPP page by scrolling down below Market Operations.

<table>
<thead>
<tr>
<th>Case Number</th>
<th>SCID</th>
<th>Date Opened</th>
<th>Subject</th>
<th>Follow Up Date</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>23526</td>
<td>IS01</td>
<td>02/09/2009</td>
<td>DMM award below bid price</td>
<td>04/26/2009</td>
<td>In Progress</td>
</tr>
<tr>
<td>25188</td>
<td>IS01</td>
<td>03/25/2009</td>
<td>HMM relationship between binding constraint, congest</td>
<td></td>
<td>In Progress</td>
</tr>
<tr>
<td>25244</td>
<td>IS01</td>
<td>03/27/2009</td>
<td>Last minute rule</td>
<td></td>
<td>In Progress</td>
</tr>
<tr>
<td>25245</td>
<td>IS01</td>
<td>03/27/2009</td>
<td>Transmission ATC for LUGO</td>
<td></td>
<td>In Progress</td>
</tr>
<tr>
<td>25249</td>
<td>IS01</td>
<td>10/19/2009</td>
<td>Test for MPP V1.4 mod</td>
<td></td>
<td>New</td>
</tr>
<tr>
<td>25294</td>
<td>IS01</td>
<td>10/19/2009</td>
<td>Test record for new change</td>
<td></td>
<td>In Progress</td>
</tr>
<tr>
<td>25295</td>
<td>IS01</td>
<td>10/19/2009</td>
<td>Test ticket # 1</td>
<td>11/01/2009</td>
<td>In Progress</td>
</tr>
<tr>
<td>25297</td>
<td>IS02</td>
<td>10/19/2009</td>
<td>Test # 2</td>
<td></td>
<td>In Progress</td>
</tr>
<tr>
<td>25302</td>
<td>IS02</td>
<td>10/30/2009</td>
<td>MPP V1.4 test record</td>
<td></td>
<td>In Progress</td>
</tr>
<tr>
<td>25306</td>
<td>IS02</td>
<td>02/19/2010</td>
<td>Test record for QA #2</td>
<td></td>
<td>In Progress</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Case Number</th>
<th>SCID</th>
<th>Trade Date</th>
<th>Charge Code</th>
<th>Charge Code Name</th>
<th>Disputed Amount</th>
<th>Disputed Status</th>
<th>Response Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>55167</td>
<td>1601</td>
<td>11/02/2008</td>
<td>4401</td>
<td>Real Time Instructed Imbalance</td>
<td>5500</td>
<td>MIP</td>
<td></td>
</tr>
<tr>
<td>55167</td>
<td>1601</td>
<td>10/01/2009</td>
<td>1801</td>
<td>Black Start Energy Payment</td>
<td>100</td>
<td>New</td>
<td></td>
</tr>
</tbody>
</table>
Customer Inquiry Dispute Page

From the California ISO Market Participant Portal page, the CIDI application is available through either the CIDI link on the left or Home Page

Click the “CIDI” link to gain access to the CIDI application. The Home page is where you can create a “New Case”, view system notices or search for existing cases.

This section will be used to communicate non-official information that is relevant to a broad spectrum of Market Participants. The exact process and content is being defined.

This is an example how the ISO will communicate information affecting a broad spectrum of Market Participants. This could be used to reduce the number of duplicate tickets submitted.

• New case entry link

• Search for cases

• Examples of Information that can be posted.
**Terminology**

**Tab** - across the top of a page. Clicking on a tab can take you to the home page, a Case page or to the Charge Code Page

**Cases page** – The tab used to create a new inquiry or a settlement dispute, each having its own unique identifying number

**Views** – are filters that display only certain records for the view criteria. You can select from pre-defined views.

**Hyperlinks** – can take you to different pages in the application
**Detail Pages** – drill down into the case created with more detailed information/fields

**Side Bar** – side bar offers a quick link to log a case, view cases, recent cases and search

<table>
<thead>
<tr>
<th>Home</th>
<th>Cases</th>
<th>Charge Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome, Student Trainer3</td>
<td>My Profile</td>
<td>Logout</td>
</tr>
<tr>
<td>Customer Portal-Helpful Links</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log a case for customer support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View cases</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search All</td>
<td>Go!</td>
<td></td>
</tr>
<tr>
<td>Advanced Search...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recent Items</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Document Image" /></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- 00030172
- 00030477
- 00030099
## Field Definitions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time Opened</td>
<td>Date and time the case was entered into the system</td>
</tr>
<tr>
<td>SCID</td>
<td>This is the ID that identifies your company. Note: Some companies have many SCIDs. Be sure to select the SCID related to the case. If the SCID is not displayed, contact the Client Representative</td>
</tr>
<tr>
<td>Subject</td>
<td>Short description of the Issue up to 255 characters. Put important information from the issue, something unique that describes issue. Example: Inaccurate OASIS ATC Values (5/25/06 – 5/31/06)</td>
</tr>
<tr>
<td>Follow Up Date</td>
<td>Used to send an email reminder for the case.</td>
</tr>
<tr>
<td>New Case</td>
<td>Used to create a “Case”, either an Inquiry or a Settlement Dispute</td>
</tr>
<tr>
<td>Description</td>
<td>Details relating to the issue. Full explanation of the subject up to 32,000 characters</td>
</tr>
<tr>
<td>Case Comments</td>
<td>Used to provide comments and communication to the ISO.</td>
</tr>
<tr>
<td>Responsible Owner</td>
<td>IMS - The client representative for the account or the ISO employee (AM) responsible for ensuring the case is resolved. SDS – The dispute analyst assigned to the case.</td>
</tr>
<tr>
<td>Client Field 1, 2, 3</td>
<td>This field is a free form text field for the user to enter key words that can be used for searching, filtering and reporting. (IMS only)</td>
</tr>
<tr>
<td>Contact Name</td>
<td>The name of the contact person for whom the issue is recorded</td>
</tr>
<tr>
<td>Contact Phone</td>
<td>The contact phone number for the contact on the case.</td>
</tr>
<tr>
<td>Contact Email Address</td>
<td>The email address for the contact on the case.</td>
</tr>
<tr>
<td>Email Recipients</td>
<td>This field allows the user to enter multiple emails that will be copied on changes to the case including significant status and case comments.</td>
</tr>
</tbody>
</table>

### Status

- **New** – A case will have this status when it is first created.
- **Assigned** – A case will have this status when an owner has been designated to work the case. This could be the client rep, a SME or a dispute analyst.
- **Awaiting Client Response** – Used to communicate to customers that there is an action/information required from them.
- **Resolved Pending Validation** – A case that has had a solution/resolution provided and is waiting for client verification. (IMS only)
- **Pending Recall** – An approved dispute case that is pending the dispute analysts’ verification of corrections associated with the dispute case on the recalculated Settlement statement.
- **Closed** – A case that the resolution has been accepted or dispute case where the Dispute Determination has been made and communicated to the Contact.
- **On Hold** – Used for unique cases that do not follow the normal 10 day target resolution process.
Basic Navigation

Select the Home tab and then select another tab for example, Charge Code and the Charge Code page is displayed (note tab is highlighted in green as being the active page. This screenshot shows Home as being active.)

This section will be used to communicate non-official information that is relevant to a broad spectrum of Market Participants. The exact process and content is being defined.

- Tabs across the top. Highlight Home tab indicates the page displayed
- Above displays a known issue and expected resolution.
- Tabs across the top. Highlight Charge Code tab indicates the page displayed
- Search drop down selection offers pre-defined searches
- To the left are examples of current ISO calendar activities or other information that can be displayed

The above screenshot shows Charge Code as being active.
Select the Cases tab and Cases Home page is displayed.

Click the drop down arrow in view and select a filtered view, such as “All Open Cases IMS”.

By selecting from the drop down in View, you can filter the cases according to IMS cases, SDS cases.

If there is a “Go” button next to selection, you must click “Go” to make the selection active.
How to Create a New Case (Inquiry Ticket)

All inquiries requiring action must be entered into the CIDI application. Each Scheduling Coordinator has an assigned Client Representative.

1. Click “Log a case for customer support” link on the Cases tab

2. The screen will indicate New Case, Select Case Record Type
   a. Select Inquiry Ticket

3. Click the Continue button

- The red bar indicates a required field.
- This defaults to Inquiry Ticket
- The choice is Inquiry Ticket or Settlement Dispute
4. The “Case Edit” screen displays:

   a. This is the Case Edit screen for Inquiry cases

5. Enter:

   - Select SCID: (Do not be concerned that the text “SCID-00xxxx” appears. This is a system value that will not remain in the SCID field once the case is saved)
   - Subject: This is a required field. This should be a short description of the issue
   - Description: This is a longer description of the case, up to 32,000 characters, and can be used to cut and paste text into the case. Pasting graphics is currently not supported and all graphics should be submitted as attachments.
   - Category: Select a Category from the drop down that you feel may the source of the case
   - Resource ID: Enter this information if applicable
   - Trade Date: If applicable type this information or select from a calendar by clicking on the field: Trade Hour: Select, all, or multiple trade hours by double clicking the available hour. Your selection will be added to the right hand chosen column

   - You must select the appropriate SCID from the search icon. All the SCIDs assigned to your digital certificate will appear here.
   - Case Type is IMS
   - Fields with the RED bar are system required fields.
6. Selecting SCID

- Click the search icon and the Lookup window is displayed
- Click on the SCID User link for the appropriate SCID

7. Click Submit or Submit and Add Attachment
8. To add an “attachment”:
   a. In this example, the Submit and Add an Attachment button was selected
   b. Follow the instructions on the page to add an attachment
   
   1. Select the File
      Type the path of the file or click the Browse button to find the file.
      
   2. Click the "Attach File" button.
      Repeat steps 1 and 2 to attach multiple files.
      (When the upload is complete the file information will appear below.)
   
   3. Click the Done button to return to the previous page.
      (This will cancel an in-progress upload.)
   
9. Click Attach File to add the file. It will appear in the window below.

10. Click Done to move to the next screen
11. Completed Case with attachment and case number

**bottom of case page**

- Original attachment
- Click Attach File to attach any additional documents
Add Comments

On the completed case page you can add any additional comments or view any comments added.

1. Click Add Comment
2. Enter new comment
3. Click Save
View Comments

You can view fewer or more comments by clicking the up and down arrows as indicated below.

Settlement Dispute cases are non-editable once submitted. If you wish to make a change to a submitted Settlements Dispute case, please contact your Client Representative, or send an email to ISODisputes@caiso.com.
Searching

The search area on the left column of the page allows you to search my case, task, notes or charge code. You can also enter a specific case #

Clicking the back arrow in the browser will take you back to the exact previous view where you were before. The “Back to List: Cases” link takes you back to the default screen before you searched. Remember to click the “Go” Button to return to the view you had previously selected.
Advanced Search allows you to search by phrase, attachment, case number or any combination.

To find all records that start with a certain phrase, you must add an asterisk (*) at the end of the word. For EXAMPLE: To find all records with the word “Test” in them, you must type “tes*”. NOT simply “tes”.
How to Create a New Case (Settlement Dispute)

All Settlement disputes must be entered into the CIDI application.

1. Click “Log a case for customer support” link on the Cases tab
2. The screen will indicate New Case, Select Case Record Type
3. Select Settlement Dispute
4. Click the Continue button

- The red bar indicates a required field.
- This defaults to Inquiry Ticket
- The choice is Inquiry Ticket or Settlement Dispute
The “Case Edit” screen displays:

a. This is the Case Edit screen for SDS cases

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCID User</td>
<td>You must select the appropriate SCID from search icon. All the SCIDs assigned to your digital certificate will appear here.</td>
</tr>
<tr>
<td>Charge Code</td>
<td>Select the appropriate Charge Code</td>
</tr>
<tr>
<td>Trade Date</td>
<td>Fields in with the <strong>RED</strong> bar are system required fields.</td>
</tr>
<tr>
<td>Trade Hours</td>
<td></td>
</tr>
<tr>
<td>Dispute Amount</td>
<td></td>
</tr>
<tr>
<td>Settlement Run #</td>
<td></td>
</tr>
<tr>
<td>Statement Disputed</td>
<td></td>
</tr>
<tr>
<td>Statement Publication Date</td>
<td></td>
</tr>
<tr>
<td>Case Reason</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
</tbody>
</table>

5. Enter all required fields:

- SCID User
- Charge Code
- Trade Date
- Trade Hours
- Dispute Amount
- Settlement Run #
- Statement Disputed
- Statement Publication Date
- Case Reason
- Description (32k char)
6. Click Submit or Submit and Add Attachment at the top or bottom of the page

   a. Follow the same method to add attachments as described above for Inquiry cases.

NOTE: Settlement Dispute cases are non-editable once submitted. If you wish to make a change to a submitted Settlements Dispute case, please contact your Client Representative or send an e-mail to ISODisputes@caiso.com.
Reports (printing cases)

CIDI offers you the ability to print an individual case detail or a view/list of cases. Below is the printable view from an individual case:

1. Click the Printable View on a case
2. Print View window is displayed
3. Click Print this page

You can save the printable version to a folder by clicking File > Save As in the print window.
You can also print from a list view.

4. Click the Printable View utility while viewing a list

5. Print View window is displayed

6. Click Print this page

<table>
<thead>
<tr>
<th>Case Number</th>
<th>Contact Name</th>
<th>SCID</th>
<th>Status</th>
<th>Subject</th>
<th>Category</th>
<th>Trade Date</th>
<th>Resource ID</th>
<th>Date Opened</th>
</tr>
</thead>
<tbody>
<tr>
<td>00026597</td>
<td>Emmett, Carolino</td>
<td>OLEN</td>
<td>Closed</td>
<td>Prin</td>
<td>Oasis</td>
<td>11/4/2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00026598</td>
<td>Emmett, Carolino</td>
<td>OLEN</td>
<td>Closed</td>
<td>Oliveale WPL</td>
<td>IFWTPM</td>
<td>11/4/2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00026590</td>
<td>Emmett, Carolino</td>
<td>OLEN</td>
<td>Closed</td>
<td>OASIS</td>
<td>Oasis</td>
<td>17/7/2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00026691</td>
<td>Vincent, Welie</td>
<td>PASA</td>
<td>Closed</td>
<td>Missing</td>
<td>MQS</td>
<td>17/11/2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00026692</td>
<td>Emmett, Carolino</td>
<td>OLEN</td>
<td>Closed</td>
<td>On 1/2</td>
<td>OASIS</td>
<td>11/14/2010</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- You can save the printable version to a folder by clicking File > Save As in the print window.
- You can also copy the page, by selecting all, ctrl A, and ctrl C to copy and then ctrl V to paste into MS Excel worksheet.
Special Tips

Entry ID

Entry ID indicates OLD IMS tickets brought over to the new CIDI system.

Back Arrow, Go, Back to List

If you use the back button on your browser it will take you back to the exact same view as you were in before you opened the case. If you use the “Back to List: Cases” link, you move back to the default screen and must push the Go button to return to the same (view in the drop down window) screen as you were at before you opened the case.
Cloning a Case

CIDI offers you an ability to clone an existing Inquiry case using the data and information already entered into the system.

1. Select an existing open case, a case not in the “closed” status.
2. Click the Clone button

A second record is created and the required fields to be updated are highlighted with a red bar.

- Status is in Resolved and pending validation - does not equal Closed
## Tracking Case Details

The Case Detail screen contains all fields specifically used for tracking case information.

- **Case Number** has been assigned.
- **Status** is Pending Recalc and **Status Reason** is blank for the case. **Type** indicates if the case is an inquiry (IMS) or a dispute (SDS).

<table>
<thead>
<tr>
<th>Case Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Number</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Status Reason</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>SCID</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dispute Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charge Code</td>
</tr>
<tr>
<td>Charge Code Name</td>
</tr>
<tr>
<td>Trade Date</td>
</tr>
<tr>
<td>Trade Hours</td>
</tr>
<tr>
<td>Settlement Run #</td>
</tr>
<tr>
<td>Settlement Disputed</td>
</tr>
<tr>
<td>Statement Publication Date</td>
</tr>
</tbody>
</table>

- The various fields can be used for tracking purposes:
  - **Charge Code**
  - **Charge Code Name**

- The fields are slightly different from the IMS cases to the SDS cases.
- Be sure to take note of the case type: IMS or SDS.
Client/Customer Responses

There are three kinds of client responses to an inquiry case, providing a generic response, accepting a resolution or declining a resolution:

- **Case status – Awaiting Client Response** – case is needing more information to assist ISO in finding a response
  
  o Press the Provide Client Response Button

- **Case status – Pending Validation** – case needs validation
  
  o Accept or Decline (with comments) the Resolution

In this example the status is Pending Validation

- Click the Accept/Decline Resolution button.
- Select Accept Resolution or Decline Resolution and enter a response.